IBM Application Discovery V5.0.5

Installation and Configuration Guide
## Contents

Chapter 1. Accessibility Features for IBM Application Discovery................................. 1

Chapter 2. Architecture Overview............................................................................... 3

Chapter 3. Installation Prerequisites........................................................................... 5
   CPU, RAM and Storage Requirements........................................................................ 5
   Supported Platforms and Versions............................................................................. 6
   Prerequisite Software and Configurations................................................................. 6
      Java Runtime Environment...................................................................................... 7
      Shared/Local Folders, Accesses and Best Practices............................................... 7
      Microsoft SQL Server Configurations................................................................... 8
      IBM DB2 for z/OS Server Configurations............................................................... 8
      AD Connect for Mainframe Prerequisites.............................................................. 9
   TCP Port Requirements and Firewall Exceptions...................................................... 9

Chapter 4. Upgrading Components from Earlier Versions............................................ 15

Chapter 5. Installing IBM Application Discovery....................................................... 19
   Installing with the ADDI Installer............................................................................. 19
   Alternative Installation for ADDI Using CLI............................................................ 20

Chapter 6. Configuring IBM Application Discovery.................................................... 21
   STEP 1. Configuring IBM AD Configuration Server.................................................. 21
   STEP 2. AD Configuration Server: Configurations for AD Build Client....................... 24
   STEP 3. Configuring AD Batch Server....................................................................... 25
   STEP 4. (Optional) Configuring AD Validation Service............................................. 29
   STEP 5. Installing AD Analyze Client...................................................................... 32
   STEP 6. AD Configuration Server: Configurations for AD Analyze............................. 33
   STEP 7. Configuring AD Analyze Client................................................................. 33
   STEP 8. (Optional) Configuring IBM AD Analyze Server......................................... 35

Chapter 7. IBM AD Connect for Mainframe Installation and Configuration............... 39

Chapter 8. Activating Your IBM Application Discovery.............................................. 41

Chapter 9. Uninstalling IBM Application Discovery Components.............................. 43

Chapter 10. Disaster Recovery..................................................................................... 45
   Backing Up Steps for Components.......................................................................... 45
      I. AD Configuration Server.................................................................................... 45
      II. AD Build Client............................................................................................... 45
      III. AD Batch Server............................................................................................ 49
      IV. AD Analyze Server......................................................................................... 51
      V. AD Analyze Client........................................................................................... 52
      VI. AD Web Services: Audit and Catalog............................................................. 52
   Restoring Steps for Components............................................................................. 53
      I. AD Configuration Server.................................................................................... 53
      II. AD Build Client............................................................................................... 53
      III. AD Batch Server............................................................................................ 54
Chapter 11. Integration with IBM License Metric Tool ....................... 57
Appendix ............................................................................................................................ 59
  recoverGDBSymbolicLinks.bat file ................................................................. 59
  recoverGDBSymbolicLinks.sh file ................................................................. 59
Documentation Notices for IBM Application Discovery ......................... 61
  Trademarks .............................................................................................................. 62
Chapter 1. Accessibility Features for IBM Application Discovery

Accessibility features assist users who have a disability, such as restricted mobility or limited vision, to use information technology content successfully.

Overview

IBM® Application Discovery includes the following major accessibility features:

- Keyboard-only operation
- Operations that use a screen reader

IBM Application Discovery uses the latest W3C Standard, WAI-ARIA 1.0 (www.w3.org/TR/wai-aria/), to ensure compliance with US Section 508 (www.access-board.gov/guidelines-and-standards/communications-and-it/about-the-section-508-standards/section-508-standards) and Web Content Accessibility Guidelines (WCAG) 2.0 (www.w3.org/TR/WCAG20/). To take advantage of accessibility features, use the latest release of your screen reader and the latest web browser that is supported by IBM Application Discovery.

The IBM Application Discovery online product documentation in IBM Knowledge Center is enabled for accessibility. The accessibility features of IBM Knowledge Center are described in the Accessibility section of the IBM Knowledge Center help (https://www.ibm.com/support/knowledgecenter/en/about/releasenotes.html).

Keyboard navigation

This product uses standard navigation keys.

Interface information

For alternative installation using Command Line Installation (CLI), refer to section Alternative Installation for ADDI Using CLI in IBM Application Discovery Installation and Configuration Guide.

The IBM Application Discovery user interfaces do not have content that flashes 2 - 55 times per second.

The IBM Application Discovery web user interface relies on cascading style sheets to render content properly and to provide a usable experience. The application provides an equivalent way for low-vision users to use system display settings, including high-contrast mode. You can control font size by using the device or web browser settings.

The IBM Application Discovery web user interface includes WAI-ARIA navigational landmarks that you can use to quickly navigate to functional areas in the application.

Related accessibility information

In addition to standard IBM help desk and support websites, IBM has a TTY telephone service for use by deaf or hard of hearing customers to access sales and support services:

TTY service
800-IBM-3383 (800-426-3383)
(within North America)

For more information about the commitment that IBM has to accessibility, see IBM Accessibility (www.ibm.com/able).
Chapter 2. Architecture Overview

The following diagram illustrates IBM Application Discovery high-level architecture and the relationships among the different components of the suite.

Following is a brief description of the relationships among the different components of IBM Application Discovery – IBM AD suite of products.

**IBM AD Configuration Server** - ensures the consistency of the installation parameters throughout an installation and allows the system administrator to manage user access to workspaces.

**IBM AD Build** - uses data from mainframe systems to build projects.

**IBM AD Build** - uses AD Connect for Mainframe to bring data from mainframe systems.
**IBM AD Validation Service** - verifies that all data that is brought from the mainframe systems is valid and ready to be compiled on the mainframe.

**IBM AD GraphDB Service** - starts the OrientDB server so that **IBM AD Analyze** can connect to OrientDB repository and use the data found there to generate the graphs.

**IBM AD Batch Server** - imports data from the relational database repository into the GraphDB (OrientDB) repository. It also automates processes such as report generation and indexing. Manages several critical clients’ configurations such as the creation of the annotations database and the reports configuration, which must be run before you start **IBM AD Analyze Client**.

**IBM AD Analyze** - analyzes mainframe projects (from **IBM AD Build**) and other types of projects (Java™, C) and displays the results of the analysis in graphs, in reports or in **Usage Analyses**.

**IBM AD Analyze Client** - uses z/OS® Explorer/CARMA to securely connect to remote mainframe systems and access/open files, which it can then analyze.

**IBM AD Web Service** - collects the data that is provided by **Web Service Metrics** component and prepares it for delivery.

**Web Service Metrics** - component generates input data for **IBM AD Web Service**.
Chapter 3. Installation Prerequisites

**Note:** Starting with IBM Application Discovery v5.0.4.1, the IBM AD Licensing Server, IBM AD Java Bridge and IBM AD Monitor Service components are no longer used, therefore must be uninstalled from your environment.

Before installing IBM AD components, make sure you install 64bit Java Runtime Environment (JRE) v1.8. Please uninstall any previous version of Java before installing v1.8; failing to do this might result in unexpected IBM Application Discovery behavior. JRE can be downloaded from http://www.oracle.com/technetwork/java/javase/downloads/index.html. Make sure to use the latest service release of Java v1.8.

Deploying IBM AD in your environment can be logically divided into two phases: *installing* IBM AD and then *configuring* IBM AD. For existing IBM AD installations, please see Chapter 4, “Upgrading Components from Earlier Versions,” on page 15 before deciding on an installation method.

**CPU, RAM and Storage Requirements**

For Production Level implementations.

(the minimum recommended hardware requirements for Production-level implementations with multiple users and projects)

- For IBM Application Discovery Dedicated Database Server:
  
  **Note:** The dedicated database server is a server with a running instance of SQL Server, dedicated to IBM Application Discovery components. It is recommended that all IBM Application Discovery components to be installed on separate machine(s).

  - CPU: Intel XEON Dual processor with minimum of 4 cores each, 3GHz or higher, with Turbo support.
  - 32GB of RAM. To avoid occasional memory reallocation, provide 64GB of RAM.
  - Dedicated hard-drive for the operating system, minimum 500GB. Secondary dedicated hard-drive for data, minimum 2TB.

- For all the IBM Application Discovery components:

  **Note:** SQL Server and all the IBM Application Discovery components can be installed on this machine for evaluation / POC purposes only.

  - CPU: Intel XEON Dual processor with minimum of 4 cores each, 3GHz or higher, with Turbo support.
  - 16GB of RAM. To avoid occasional memory reallocation, provide 24GB of RAM.
  - Dedicated hard-drive for the operating system, minimum 500GB. Secondary dedicated hard-drive for data, minimum 2TB.
  - 4GB allocated Virtual Memory.

- For IBM Application Discovery Build Client and/or Analyze Client:

  - CPU: Intel i3 or equivalent.
  - 4GB of RAM. To avoid occasional memory reallocation, provide 8 GB of RAM.
  - 15 GB allocated disk space.

For Evaluation / POC implementations.

(the minimum recommended hardware requirements for evaluating the IBM Application Discovery Suite in an Windows environment)

- For IBM Application Discovery Workstation:

  - CPU: Intel Core i5 or equivalent.
- 8 GB of RAM. To avoid occasional memory reallocation, provide 16GB of RAM.
- 35 GB allocated disk space.

**Supported Platforms and Versions**

IBM Application Discovery Analyze Server/Batch Server/Configuration Server can be installed on:

- Windows 7 SP1, 64bit
- Windows 8 64bit
- Windows 10 64bit
- Windows Server 2008 R2 SP1, 64bit
- Windows Server 2012 R2, 64bit
- Windows Server 2016 64bit
- Linux RedHat v7 64bit or latest stable release
- Linux Ubuntu LTS 64bit v16.0 or latest stable release
- Linux SuSE 42.3 64bit or latest stable release

IBM Application Discovery Build/Analyze Client can be installed on:

- Windows 7 SP1, 32/64bit
- Windows 8 32/64bit
- Windows 10 32/64bit
- Windows Server 2008 R2 SP1, 32/64bit
- Windows Server 2012 R2, 32/64bit
- Windows Server 2016 64bit

SQL Server version can be:

- Microsoft SQL Server 2008, Standard Edition or later
- Microsoft SQL Server 2012, Standard Edition or later
- Microsoft SQL Server 2014, Standard Edition or later
- Microsoft SQL Server 2016, Standard Edition or later

**Note:** Microsoft SQL Server Express® Edition may be used for IBM AD Suite evaluation purposes only.

DB2® for z/OS version can be:

- IBM DB2 for z/OS version 11.1 or later

**Prerequisite Software and Configurations**

- **Eclipse Classic / RCP and RAP Developers**
  32/64 bit Eclipse Classic (RCP and RAP Developers), minimum supported version v4.4. Eclipse Classic can be downloaded from [www.eclipse.org](http://www.eclipse.org).

- **IBM Rational® Development for z Systems® (RDz)**
  Supported versions are v9.1.x to v9.5.x.

- **IBM Developer for z Systems (IDz)**
  Minimum supported version is v14.0.0.0.

- Internet browsers (used for accessing the IBM Application Discovery Configuration Server):
  - Recommended: Mozilla Firefox or Google Chrome latest versions.
• Supported: Microsoft EDGE, Microsoft Internet Explorer v11.

Note: Make sure to enable Java Script on your Internet browser of choice.

Java Runtime Environment

• 64 bit Java 8 Oracle/IBM must be installed before any IBM AD components.

• 32/64 bit Java 8 Oracle/IBM must be installed before any IBM AD Client components.

Please uninstall any previous version of Java before installing the newest version and make sure to use the latest service release of Java v1.8. Failing to do this might result in unexpected IBM Application Discovery behavior.

Java can be downloaded from:


Important: Please make sure the path for Java is set in your system as follows: Start > System > Advanced Settings > Environment Variables > System variables > Path. The path to the Java installation folder must be set to include the bin folder as in C:\Program Files\Java\jre1.8.0_131\bin.

Shared/Local Folders, Accesses and Best Practices

1. AD Analyze Client.
   a. Local Eclipse and Local Workspace Folders: all the users that access IBM Application Discovery Analyze Client should have read/write rights for their Eclipse Installation folder and Local Workspace Folder on their Analyze Client machine.

2. AD Analyze Server (Optional)
   a. A shared folder must be created, and referenced in AD Analyze Server manager, for the Shared Java Projects, and all the users operating IBM Application Discovery Analyze must have read/write access rights for it.
   b. The user under which the Windows service / Linux process runs, must have write access rights in the installation folders.

3. AD Build Client shared folders need read/write access rights, for:
   a. Projects (read/write access for both AD Build/Analyze client users)
   b. Configurations (zOS Connections) (read/write access for AD Build Client users)
   c. Sources (write access for IBM AD Build and IBM AD Batch Server users and read for AD Analyze Client users).

   Note: If you want to visualize these sources in Endevor or Changeman, read access to local sources is not required.

4. In order for AD Batch Server to run correctly, the user credentials under which the Windows service / Linux process runs, needs to have read/write access rights for the following folders:
   a. Indexes folder. STE5. Configuring AD Batch Server - procedure step 5c
   b. Installation folder.

   Note: The following folder structure is a best practice example of how IBM Application Discovery installation folder should look like however, you can customize the structure based on your particular needs.
Note: For the situation when all AD Build Components are running on a single machine, so no external AD Build/Analyze Clients are used, local paths instead of shared, can be used.

Microsoft SQL Server Configurations

Most IBM Application Discovery components connect to an SQL Server using SQL Authentication. For SQL Server 2008/2012/2014/2016, perform the following configurations:

1. Make sure Microsoft SQL Server Agent service is started.
2. Setting up an SQL user account:
   a. Launch SQL Server Management Studio.
   b. Expand Security > Logins then right-click Logins and choose New Login. Add a login name, select SQL Server Authentication, add a password, and make sure that the default database is set to master. This user will be referred to as IBM Application Discovery SQL Identity.
   c. Expand Databases > System Databases > master > Security > Users then right-click Users and choose New User. Choose the IBM Application Discovery SQL Identity user and click OK.
   d. Expand Databases > System Databases > master then right-click master and choose Properties. Go to Permissions tab and for the IBM Application Discovery SQL Identity user and click OK.
   e. The following permission must be granted only if the Rename project feature is used in IBM Application Discovery Build, otherwise this is not needed. Right-click on the SQL server instance then select Properties. In the Server Properties window select Permissions: From the roles list, select the IBM Application Discovery SQL Identity and then select Grant for Alter any database permission.

Important: Make sure the SQL Server Agent runs on the same machine as the SQL Server.

IBM DB2 for z/OS Server Configurations

DB2 Connect™ V11.1 must be licensed for each AD Analyze Client and AD Build Client. On the computers that AD Build Client is installed, Data Server Client V11.1 that contains OLE DB Provider must be installed.

Some packages must be bound on the server. The bound files are listed in the ddcsmvs.lst file for IBM Z, for example, C:\Program Files\IBM\SQLLIB_01\bnd\ddcsmsv.lst.

User permissions

In an AD application, a z/OS user account is used to work with the DB2 for z/OS repositories. The user account must have permissions to perform the following actions:

- Use the storage group that is specified in the AD configurations.
- Use the SYSDEFLT default storage group.
- Use the default buffer pools.
• Create and use databases, tables, table spaces, indexes, constraints, views, triggers, stored procedures, and user-defined functions.
• Run the SELECT command over system tables (SYSIBM.SYS*).
• Have full control over the databases that are created by the user account.
• GRANT ARCHIVE, STOSPACE, BINDADD, BINDAGENT, CREATEDBA, CREATESG, DISPLAY, SYSOPR
• GRANT ALTERIN, CREATEIN, DROPIN ON SCHEMA *
• GRANT PACKADM ON COLLECTION *
• GRANT SELECT, INSERT, UPDATE, DELETE ON TABLE SYSIBM.SYSROUTINES_SRC
• GRANT SELECT, INSERT, UPDATE, DELETE ON TABLE SYSIBM.SYSROUTINES_OPTS

AD Connect for Mainframe Prerequisites

IBM Application Discovery Connect for Mainframe can be installed on:
• z/OS version 2.1 or later.
• The maximum storage space is 5 cylinders.

Before installing IBM Application Discovery Connect for Mainframe on the host machine (mainframe), you need to take the following steps:
1. Authorize to add IBM Application Discovery Connect for Mainframe’s load library to APF.
2. Authorize IBM Application Discovery Connect for Mainframe’s listener to run.
3. Authorize to access all libraries specified in the STEPLIB card (see section Configuring the listener PROC in the IBM Application Discovery Connect for Mainframe Installation Guide document).

3. Make sure to provide authorization according to the analyzed area:

<table>
<thead>
<tr>
<th>Analyzed Area</th>
<th>Required Authorization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adabas</td>
<td>Authorization to issue an ADAREP command</td>
</tr>
<tr>
<td>Control-M</td>
<td>Access to the libraries containing the Control-M data</td>
</tr>
<tr>
<td>DB2</td>
<td>Rights to read from the DB2 system tables (SYSIBM)</td>
</tr>
<tr>
<td>SMF</td>
<td>Access to the SMF dump files</td>
</tr>
<tr>
<td>Libraries and Members</td>
<td>Access to the libraries</td>
</tr>
<tr>
<td>Natural</td>
<td>Authorization to issue a Natural batch command and read Access to all Natural libraries (LOGON)</td>
</tr>
<tr>
<td>Operator commands</td>
<td>Normal RACF® security to allow the user to issue those commands.</td>
</tr>
<tr>
<td>WebSphere® MQ</td>
<td>Authorization to perform PUT and GET from command and reply queues</td>
</tr>
</tbody>
</table>

TCP Port Requirements and Firewall Exceptions

The following table summarizes the TCP ports that need to be allowed by the firewall in order for the Application Discovery Suite to function as intended.

In all cases, communication is bidirectional. The firewall must allow both the incoming traffic, which represents requests, for the mentioned ports, and the outgoing traffic, which represents the answers to these requests.
<table>
<thead>
<tr>
<th>From (Sender)</th>
<th>To (Listener Component)</th>
<th>Default Listener Port</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>• AD Analyze Clients</td>
<td>SQL Server</td>
<td>TCP 1433</td>
<td>The port of the SQL Server Database Engine instance that hosts the AD databases. Majority of the AD components use this port to read/write data from/into the SQL databases. The default instance of the SQL Server Database Engine listens on TCP port 1433, but it can be changed via SQL Server admin tools. Ask your database server administrator what port is used by the SQL server instance that is used by AD. Make sure not to use TCP port 1434, which is used by Dedicated Administration Console (DAC).</td>
</tr>
<tr>
<td>• AD Audit Service</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AD Batch Server</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AD Build Client</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AD Build Configuration</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AD Catalog</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The computer where the browser session is opened</td>
<td>AD Configuration Server</td>
<td>TCP 8080</td>
<td>The port that is used to access the web interface of AD Configuration Server. The default port is 8080, but it can be changed in the admin-ws.properties file, which is located in the conf folder where AD Configuration Server is installed. If the web interface is accessed only locally on AD Configuration Server, this port does not have to be opened in the firewall.</td>
</tr>
<tr>
<td>• AD Analyze Clients</td>
<td>AD Configuration Server</td>
<td>TCP 2181</td>
<td>The port that AD Configuration Server listens on for requests from various AD components that need to obtain the configuration settings from AD Configuration Server. The default port is 2181, but it can be changed in the server.properties file, which is located in the conf folder where AD Configuration Server is installed.</td>
</tr>
<tr>
<td>• AD Batch Server</td>
<td></td>
<td>TCP 2424 - TCP 2430</td>
<td>The port of the OrientDB database instance that is hosted by AD Batch Server. AD Analyze Client makes requests to this port for retrieving the data that is related to callgraph analyses. OrientDB uses the first free TCP port in the range 2424 - 2430. This can be changed in the config/orientdb-server-config.xml file under port or IP settings.</td>
</tr>
<tr>
<td>• AD Analyze Server</td>
<td>AD Analyze Server</td>
<td>TCP 1099</td>
<td>The port where the Remote Method Invocation (RMI) registry can be found on AD Analyze Server. AD Analyze Clients make RMI-specific requests to this port. The default port is 1099, but it can be changed from AD Analyze Server Manager. To change the setting, click Server Settings &gt; RMI Registry Port.</td>
</tr>
<tr>
<td>From (Sender)</td>
<td>To (Listener Component)</td>
<td>Default Listener Port</td>
<td>Note</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| AD Analyze Clients  | AD Analyze Server       | TCP 1900              | The port that is used by AD Analyze Server for the Remote Method Invocation (RMI) communication. AD Analyze Clients make requests to this port for obtaining various information that is needed for Java analyses.  
The default port is 1900, but it can be changed from AD Analyze Server Manager. To change the setting, click **Server Settings > Export Port**.  
AD Analyze Server is required only when AD Analyze Clients use and run Java-specific analyses, so if AD Analyze Server is not installed, the port does not have to be opened in the firewall. |
| AD Analyze Server   | AD Analyze Client       | A random free TCP port, which is allocated at run time, in the ephemeral port range 49152 - 65535. | The port that AD Analyze Client listens on for notifications from AD Analyze Server. This port is temporarily used, which is released after the application is closed.  
The default port is a random free TCP port, which is allocated at run time, in the ephemeral port range 49152 - 65535, but AD Analyze Client can be configured to use a specific port. To configure the setting, click **Window > Preferences > Application Discovery > Local Settings > General Settings > Client Settings** in Eclipse, and then set a value in the range 1 - 65535 in the **Port** field. Value 0 means that a free port on AD Analyze Client is selected at run time in the ephemeral port range 49152 - 65535.  
AD Analyze Server is required only when AD Analyze Clients use and run Java-specific analyses, so if AD Analyze Server is not installed, the port does not have to be opened in the firewall. |
| • AD Build Client   | • AD Build Configuration | Any available TCP port (no default value) | The port that AD Connect for Mainframe listens on. It is used by AD Build Configuration to retrieve source code information and operational information from the mainframe, and used by AD Build Client to retrieve source code files from the mainframe.  
For how to set or change the port that is used by AD Connect for Mainframe, see section Configuring the Listener PROC in *IBM Application Discovery Connect for Mainframe Configuration Guide*. There is no default port that is specified. Any available port can be selected. For example, port 6000 or port 46000.  
After you change this port in AD Connect for Mainframe, the zOS connection setup needs to be |
<table>
<thead>
<tr>
<th>From (Sender)</th>
<th>To (Listener Component)</th>
<th>Default Listener Port</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD Connect for Mainframe</td>
<td>AD Validation Service</td>
<td>Any available TCP port (no default value)</td>
<td>The port that AD Validation Service listens on for validation requests from AD Connect for Mainframe. It can be configured in the ServicePort.txt configuration file that is located in the AD Validation Server installation folder. No default port is set by default. Any available TCP port can be used. For example, port 48000. AD Validation Service is an optional component. If it is not used, this port does not have to be opened in the firewall.</td>
</tr>
<tr>
<td>• AD Analyze Clients</td>
<td>AD Audit Service</td>
<td>TCP 9080</td>
<td>The port that AD Audit Service listens on to receive requests from various AD components for logging audit events. The port number can be changed by altering the httpPort value in the server.xml file. The file is located in the folder of the IBM Liberty instance that hosts AD Audit Service. After you change this port, make sure to reconfigure the AD components that audit events to use the new port. For more information, see IBM Application Discovery Web Services User Guide. The AD Audit and AD Catalog services are optional AD components. They are both hosted by the same WebSphere Liberty instance. If neither of them is used, the port does not have to be opened in the firewall.</td>
</tr>
<tr>
<td>• AD Batch Server</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AD Build Client</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• AD Analyze Clients</td>
<td>AD Catalog Service</td>
<td>TCP 9080</td>
<td>The port that AD Catalog Service listens on. This port is used by AD Data Collector to push data into AD Catalog, and it is used by AD Analyze Clients to retrieve the data that is needed for displaying API analyses. The port number can be changed by altering the httpPort value in the server.xml file. The file is located in the folder of the IBM Liberty instance that hosts AD Catalog Service. After you change this port, make sure to reconfigure AD Data Collector and AD Analyze Client to use the new port. For more information, see IBM Application Discovery Web Services User Guide. The AD Audit and AD Catalog services are optional AD components. They are both hosted by the same WebSphere Liberty instance. If neither of them is used, the port does not have to be opened in the firewall.</td>
</tr>
<tr>
<td>• AD Data Collector</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Note:** Make sure that the firewall does not prevent AD Analyze Client from communicating with AD Batch Server, AD Configuration Server, AD Analyze Server, and the relational database server. Program rules in the firewall might need to be created to allow both the inbound and outbound traffic for the `eclipse.exe` instance on each AD Analyze Client that is located under the installation folder of your Eclipse, IDz, or RDz instance.
Chapter 4. Upgrading Components from Earlier Versions

Upgrading from IBM AD V5.0.5.0 or later
To upgrade from IBM AD V5.0.5.0 or later versions, you can run the ADDI installer without uninstalling AD components.

To upgrade from IBM AD V5.0.5.0 to V5.0.5.1, after the upgrade is completed, you must re-create the graph database password by running the <installation path>IBM Application Discovery Batch Server\orientdb\orientdb-community-2.1.5_ezpatch1\bin\server.bat file. The new password must be the same as the password before upgrade.

Upgrading from IBM AD V5.0.4.2 or earlier
Before upgrading from IBM AD V5.0.4.2 or earlier versions, you must back up the configurations and uninstall the IBM AD components.

Important: Please note that the location of the products you are about to install might be different than the one from previous installations. To maintain the existing configurations, be sure to:

• Back up the configurations before uninstalling the application by following the backup steps described below under each application.
• Once the application is installed, restore the backed-up configurations by manually copying them into the new location.

Before you upgrade to a newer version, follow the steps to keep your old configurations:

IBM Application Discovery Configuration Server (from v5.0.2.x onwards)
To back up the data from IBM AD Configuration Server (also the projects published by IBM AD Build Client in IBM AD Configuration Server), please make sure you keep:

• The store folder.
• The conf folder.

Both folders are stored under the IBM AD Configuration Server installation folder. To restore these settings copy them from the backup location into the new installation folder.

IBM Application Discovery Analyze Server
When uninstalling the IBM AD Analyze Server, there is an automated process that creates a backup for the server.properties and client.properties files, renaming them to server.properties.bak and client.properties.bak. If you want to keep previous settings, please make sure you do not delete these files. They are kept under the installation folder. To restore these settings, copy server.properties.bak and client.properties.bak from the backup location to the new installation folder and rename them back to server.properties and client.properties.

IBM Application Discovery Batch Server
To back up the data from IBM AD Batch Server make sure you don’t delete:

• The conf folder. Note that from one version to another, the server.properties and the project.properties files structure might change. It is better not to overwrite the new files with the old ones, but instead to copy the parameters and their values that were modified by the administrator from the old files into the same parameter/value settings in the corresponding new files.
• The data folder.
• The orientDB folder.
All the folders are kept under the installation folder. To restore these settings copy them from the backup location into the new installation folder.

Details on how to back up the Symbolic Links: The following part describes how to manually move the Symbolic Links to a temporary location depending on the OS used (Windows or Linux System).

1. On Windows. Before uninstalling IBM Application Discovery Batch Server:
   - Go to Start menu under IBM Application Discovery Batch Server and stop IBM Application Discovery Web Service, IBM Application Discovery OrientDB Service and IBM Application Discovery Batch Service.
   - Backup the content of databases folder present under \IBM Application Discovery Batch Server installation folder>orientdb\orientdb-community-2.1.5_ezpatch1\databases using the following command in a command prompt window:

   ```
   robocopy "path to source folder" "path to the target folder" /S /SL
   ```

   **Note:** Path to source folder is the path to the databases folder under IBM Application Discovery Batch Server installation folder. Path to the target folder is the path to a folder created on the disk where the content of the databases folder will be copied. (example: robocopy "C:\Program Files\IBM Application Discovery Batch Server\orientdb\orientdb-community-2.1.5_ezpatch1\databases" "C:\databases" /S /SL)

   - Once you install IBM Application Discovery Batch Server use robocopy command to copy from the folder where the symbolic links were saved to the databases folder under \IBM Application Discovery Batch Server installation folder>orientdb\orientdb-community-2.1.5_ezpatch1. (Example: robocopy "C:\databases" "C:\Program Files\IBM Application Discovery Batch Server\orientdb\orientdb-community-2.1.5_ezpatch1\databases" /S /SL)

2. On Linux (from v5.0.4.1 onwards). Before uninstalling IBM Application Discovery Batch Server:
   - Stop IBM Application Discovery Web Server, IBM Application Discovery OrientDB Server and IBM Application Discovery Batch Server.
   - Backup the content of databases folder present under \IBM Application Discovery Batch Server installation folder>orientdb\orientdb-community-2.1.5_ezpatch1\databases using the following command in a terminal:

   ```
   cp -Prv "path to source folder" "path to the target folder"
   ```

   **Note:** Path to source folder is the path to the databases folder under IBM Application Discovery Batch Server installation folder. Path to the target folder is the path to a folder created on the disk where the content of the databases folder will be copied (Example: cp -Prv /home/user/IBM\ Application\ Discovery\ Batch\ Server/orientdb/orientdb-community-2.1.5_ezpatch1/databases/* /home/user/databases)

   - Once you install IBM Application Discovery Batch Server use the same command to copy from the folder where the symbolic links were saved to the databases folder under under \IBM Application Discovery Batch Server installation folder>orientdb\orientdb-community-2.1.5_ezpatch1. (Example: cp -Prv /home/user/databases/* /home/user/IBM\ Application\ Discovery\ Batch\ Server/orientdb/orientdb-community-2.1.5_ezpatch1/databases)

IBM Application Discovery Build Client

**Important:** When upgrading from IBM AD Build v5.0.1.x to v5.0.4.1, take the following steps:

1. Uninstall the existing v5.0.1.x components.
2. Install any v5.0.3.x AD Build Configuration and Client.
3. Install IBM AD Configuration Server v1.0.6, which is included with IBM Application Discovery v5.0.3.x.
4. From AD Build Configuration Administration tool, click Publish Projects.
5. Once the projects have been published, uninstall the v5.0.3.x Build Components and v1.0.6 IBM AD Configuration Server.

6. Proceed with 5.0.4.1 installation.

**Important**: When upgrading from IBM AD Build v5.0.2.x to v5.0.4.1:

Once the installation of IBM AD Build Client is done (on the same machine where previous version of IBM AD Build Configuration was installed), a file called ConfigurationParameters.txt is automatically generated in the installation folder under the folder bin, subfolder release. This file contains all information related to the configurations made in IBM AD Configuration Server for IBM AD Build Client:

- Path for the Mainframe Connection (Path)
- Encoding (Japanese / No Encoding)
- Member Synchronization information (Yes / No and Path)
- Enable Communication Logging (Yes / No)
- Keep communication buffers (Yes/No)

**Note**: The user must add these configurations in the IBM AD Build Client settings page from IBM AD Configuration Server. This step is a must to maintain the old configurations.
Chapter 5. Installing IBM Application Discovery

You can use the IBM Application Discovery and Delivery Intelligence (ADDI) installer or Command Line Installation to install IBM Application Discovery.

Installing with the ADDI Installer

To install IBM Application Discovery on Windows or Linux, use the IBM ADDI installer. You can also use the IBM ADDI installer to install IBM Application Delivery Intelligence (ADI).

Procedure

1. To run the IBM ADDI installer, double-click the `IBM_Application_Discovery_and_Delivery_Intelligence_Installer-5.0.5.0.exe` file.
2. On the **Welcome** page, click **Next**.
3. On the **Licensing Agreements** page, click **I accept the terms of this license agreement**, and then click **Next**.
4. On the **Installation Path** page, specify the installation path, and then click **Next**. The default installation path is `C:\Program Files\IBM Application Discovery and Delivery Servers`.
   If the installation path that you specify does not exist, the target directory is created. Confirm the path, and click **OK** in the **Message** dialog box.
5. On the **Select Installation Components** page, select the components that you want to install, and then click **Next**. The components that are not applicable for the current system cannot be selected.

   ![Select Installation Components wizard page](image)

   *Figure 2: Select Installation Components wizard page*

6. On the **User Data** pages, specify the settings and click **Next**.
   a. Starting from IBM ADDI V5.0.5.1, if an IBM ADI check box is selected in step 5, you can specify the ADI installation path. The default installation path is `C:\ibm`.
   b. Specify the configuration service IP address and port number.

After all the components that you selected are installed, the installation is completed.
Alternative Installation for ADDI Using CLI

In case you do not have access to a graphic interface, please follow this procedure to install the IBM Application Discovery Servers:

1. Navigate to the IBM Application Discovery Servers installation path and open a command line.
2. For regular installation, run the following command:
   
   ```
   java -jar <installer name> -c
   ```
3. For a silent installation, run the following command:
   
   ```
   java -jar <installer name> -f <path to install xml file>
   ```
Chapter 6. Configuring IBM Application Discovery

After IBM Application Discovery is installed, follow the steps to configure the components.

STEP 1. Configuring IBM AD Configuration Server

About this task
The IBM Application Discovery Configuration Server component can run with the default settings. If the default settings are not compatible with your environment, you can configure the component and overwrite the default settings.

Procedure
1. Configure the settings in the IBM_AD_Configuration_Server_Folder/conf/server.properties file.
   a) Configure the port that AD Configuration Server listens on by setting the value of the server.port parameter.
      The default value is 2181.
   b) Configure the number of the snapshots and the corresponding logs that are retained by AD Configuration Server. To configure the setting, set the value of the zookeeper.autopurge.snapRetainCount parameter.
      The default value is 4, and the minimum value is 3.
   c) Configure the time interval in hours for the purge task by setting the value of the zookeeper.autopurge.purgeInterval parameter.
      The purge task deletes old snapshots and the corresponding log files according to the time interval. The default value of the parameter is 24. To enable the purge task, you must set a value that is greater than 0.
2. Configure the web server settings in the IBM_AD_Configuration_Server_Folder/conf/webservice.log4j.properties file.
   a) Configure the root logger level and the appenders by setting the log4j.rootLogger parameter with one of the following values:
      • OFF
      • FATAL
      • ERROR
      • WARN
      • INFO
      • DEBUG
      • TRACE
      • ALL
      The default log level is INFO. The default appenders are file, which indicates a rolling file appender, and stdout, which indicates a console appender.

   Example
   
   
   log4j.rootLogger=DEBUG

   b) Configure the file roller appender log level by setting the log4j.appender.file.threshold parameter with one of the following values:
- OFF
- FATAL
- ERROR
- WARN
- INFO
- DEBUG
- TRACE
- ALL

**Note:** If you do not set the value of the log4j.appender.file.threshold parameter, the file roller appender log level is the same as the root logger level. To set the log4j.appender.file.threshold parameter, the value must be lower than or equal to the root logger level.

**Example**

```
log4j.appender.file.threshold=ERROR
```

c) Configure the file roller appender location by setting the value of the log4j.appender.file.File parameter.

**Note:** The value of the log4j.appender.file.File parameter must be a valid absolute or relative path.

**Example**

```
log4j.appender.file.File=/home/user/logs/webservice.log
```

d) Configure the file roller appender minimum number of backup files to keep by setting the value of the log4j.appender.file.MaxBackupIndex parameter.

**Example**

```
log4j.appender.file.MaxBackupIndex=5
```

e) Configure the file roller appender maximum file size by setting the value of the log4j.appender.file.MaxFileSize parameter.

**Example**

```
log4j.appender.file.MaxFileSize=100M
```


The web server is attached to AD Configuration Server.

a) Configure the network interface that the web server listens on by setting the value of the host parameter.

The default value is `localhost`.

**Note:** To expose the web server, you must set the host parameter with one of the following values:

- **IP address**
  One of the IP addresses that are attached to a network interface on the computer where AD Configuration Server is running.

- **0.0.0.0**
  Exposes the web server to all network interfaces.

b) Configure the port that the web server listens on by setting the value of the port parameter.

The default value is `8080`.

**Note:** If the web server is exposed to the network, the communication on the specified port must be enabled by the firewall.
c) Configure the path to the configuration file of the logger by setting the value of the log-conf-file parameter.

The default value is `IBM_AD_Configuration_Server_Folder/conf/webservice.log4j.properties`.

4. By default, the HTTP protocol is used to run the web service. To use the SSL/HTTPS protocol, follow the steps:

a) Generate a self-signed key pair and store it in a Java keystore by using the Java Keytool command line interface. Run the following command:

    ```
    Note: Java SDK or Java JRE must be installed, and the JAVA_HOME and PATH environment variables must be configured for the Java SDK or Java JRE.
    ```

    ```
    keytool -genkeypair -keyalg RSA -alias {alias}  
    -ext SAN=DNS:localhost,IP:127.0.0.1 -dname {dname}  
    -validity {validity} -keysize 2048 -keypass {keypass}  
    -storepass {storepass} -keystore {keystore}
    ```

    **{alias}**
    - The name that is used by the Java keystore to identify the generated key. The name must be unique within the Java keystore.

    **{dname}**
    - The distinguished name from the X.500 standard. This name is associated with the alias for the key pair in the keystore. Also, the name is used as the value in the "issuer" and "subject" fields in the self-signed certificate.

    **{validity}**
    - The number of days that the certificate that is attached to the key pair is valid.

    **{keypass}**
    - The password that is needed to access the key pair within the keystore.

    **{storepass}**
    - The password for the Java keystore.

    **{keystore}**
    - The path to the keystore file, which is used to store the generated key pair. If the file does not exist, a keystore file is created.

    **Example**

    ```
    keytool -genkeypair -keyalg RSA -alias my-key-pair  
    -ext SAN=DNS:localhost,IP:127.0.0.1 -dname CN="IBM AD"  
    -validity 9999 -keysize 2048 -keypass my-key-password  
    -storepass my-store-password -keystore C:\my_keystore
    ```

b) Configure the web server that is attached to IBM Application Discovery Configuration Server to use the SSL/HTTPS protocol. In the `IBM_AD_Configuration_Server_Folder/conf/keystore-config.properties` file, configure the following parameters:

    **path**
    - Set the value to the path of the Java keystore that is generated in the preceding substep.

    **storepass**
    - Set the value to the password for the Java keystore.

    **keypass**
    - Set the value to the password that is needed to access the key pair within the keystore.

c) In the `IBM_AD_Configuration_Server_Folder/conf/admin-ws.properties` file, set the value of the keystore-conf-file parameter to the path of the keystore configuration file.
STEP 2. AD Configuration Server: Configurations for AD Build Client

About this task

IBM Application Discovery Configuration Server ensures that the installation parameters are consistent throughout the different components of IBM Application Discovery by storing them in a central location, in a scalable, and fail-safe manner.

IBM Application Discovery Configuration Server additionally allows the system administrator to manage the shared resources publishing and to coordinate the access to the shared resources by creating workspaces and user groups.

Procedure

1. Start IBM Application Discovery Configuration Server, by selecting Start > All Programs > IBM Application Discovery Configuration Service > Launch IBM Application Discovery Configuration Service Admin.

2. Create an environment, in IBM Application Discovery Configuration Server main page, by selecting the localhost server. From the available options, select Environments then click Add Environment. Enter a name and a description for the new environment then click Save. Select the newly defined environment. A Default workspace is automatically created for the new environment and is attached to it. Also, a Default blank configuration is automatically created and attached to the new environment.

Note: The environment ID will be later used in AD Batch Server and AD Analyze Client configurations.

3. Go to localhost:2181 > Install Configurations > IBM Application Discovery Build Client and configure the following parameters.

   a) Default Project path: A default path where all AD Build Client projects are stored. This must be a shared path (with read/write access rights) so that it can be accessed by any AD Build, Analyze...
**Clients** and **AD Batch Server**. This default path can be changed while creating a Project in **AD Build Client**.

b) **zOS configuration folder**: A default path where the zOS Connections are stored. This must be a shared path with read/write access rights so that it can be accessed by any **AD Build Client / AD Build Configuration** Administration tool.

c) **Path for the retrieved members**: A default path where all the members downloaded from a Mainframe system are stored. This must be a shared path (with read/write access rights) so that it can be accessed by any **AD Build, Analyze Clients and AD Batch Server**.

**Note**: For the situation when **AD Build Client, AD Analyze** and **AD Batch Server** are on the same machine as these paths, and no other external **AD Build / Analyze Clients** are to be installed, this path can be a local one with read/write access rights.

4. To add a relational database server, in **IBM Application Discovery Configuration Server** main page, from the available servers, select the localhost server where you defined your environment. From the available options, select **Environments > your Environment** then click **Relational database servers**. Click **Add relational database server** and enter the following parameters:

   • **Name**: Enter a name for the relational database server.
   • **Host**: IP or name of the computer where the relational database server is installed.
   • **Port**: The relational database server port. The default port for SQL Server is 1433.
   • **Instance/Location**: The relational database server instance name (if exists).
   • **Username/Password**: User name and password for the **IBM Application Discovery SQL Identity** as defined in “Microsoft SQL Server Configurations” on page 8, or for the DB2 for z/OS instance.

5. At this point, you can create new projects in **AD Build Client**.

**Note**: For more information on how to create new projects, please refer to **IBM Application Discovery Build User Guide**.

**Note**: In order to activate your IBM AD Build Client copy, follow the procedure described in Chapter 8, “Activating Your IBM Application Discovery,” on page 41.

### STEP 3. Configuring AD Batch Server

**About this task**

Before running **IBM Application Discovery Batch Server**, some preliminary configurations must be performed. You need to specify on which projects you want **IBM Application Discovery Batch Server** to run the reports, which reports to generate, where to store the generated reports, and so on. Also, you need to specify the parameters for **IBM Application Discovery Web Service**.

The configuration parameters are stored in `server.properties` and `project.properties` files, which can be found in the configuration folder.

Below are the instructions on how to perform a minimal configuration in order to have source code analysis in **IBM AD Analyze Client**. For detailed instructions on how to configure **IBM Application Discovery Batch Server**, see IBM Application Discovery Batch Server Configuration Guide.

**Note**: Under Linux, in case .sh files are not executable, navigate to their installation directory, open a terminal and run the following command for flagging them as executable:

```
chmod +x filename.sh
```

**Procedure**

1. Go to `<IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\orientdb\orientdb-community-2.1.5_ezpatch1\bin` and run `server.bat` on **Windows**
and server.sh on Linux. A command prompt window will open, asking for the root user account password. Fill in a password of your choosing and press ENTER. A message indicating that the service is now active is displayed.

**Note:** At this point, OrientDB is configured to run with the root user name and the password configured above.

2. Configure the username and password used for IBM AD Batch Server to connect to the relational database or graph database by following these steps:

   a) For the relational database server: Go to `<IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\`, and run sqlUserSetup.bat on Windows and sqlUserSetup.sh on Linux. A command prompt dialog window is displayed. Follow the directions and fill in the username and the password defined for the IBM Application Discovery SQL Identity user, so that it can be used by the IBM AD Batch Server to connect to SQL databases, then press ENTER. For DB2 for z/OS, insert the username and password that are used for the DB2 for z/OS database.

   **Note:** The user name and password must match the corresponding values defined as part of the Relational database server, as declared in AD Configuration Server: Configurations for AD Build Client / step 4.

   b) For OrientDB: Go to `<IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\`, and run gdbUserSetup.bat on Windows and gdbUserSetup.sh on Linux. A command prompt dialog window is displayed. Follow the directions and fill in the username (root) and the password used by IBM AD Batch Server to connect to OrientDB databases (the same password configured at step 1 in this procedure when server.bat or server.sh was run), then press ENTER.

3. Copy from `<IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\sample-conf` all the configurations files and sub folders to `<IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\Conf`.

4. In server.properties file, set the following parameters.

   • ccs.server.host=<IP / hostname of the machine where the AD Configuration Server resides.>
   • ccs.environment=<the same environment ID defined in Configuration Server.>
   • sql.server.host=<the same IP / hostname defined in Configuration Server.>

   Make sure that you enter for sql.server.host the same value set for the Host parameter of the relational database server definition in IBM Application Discovery Configuration Server.

   **Note:**

   • sql.server.instance must be configured, if there is an instance/location name declared in AD Configuration Server: Configurations for AD Build Client.

   • sql.server.port must be configured, if the port filled in AD Configuration Server: Configurations for AD Build Client is different than default (1433).

   **Attention:** In order for the parameters to be taken into account, the comment tag # must be removed.

5. The project.properties file contains a set of global settings, followed by the specific settings for each type of component. The global settings specify the projects on which the IBM Application Discovery Batch Server will operate and which components will run on the specified projects. In project.properties file, set the following parameters.

   a) Enter an asterisk *, or a comma-separated list of project names that are the only ones considered for this service. VERY IMPORTANT: If no value is set for this parameter, no report is generated; * means all projects.

   ```
   projects.whitelist=*
   ```
b) Comma-separated list of component names that must be considered for this service. Ex.: index must be added as a component.

components=index,gdbImport,annUpdate

Optional components can be considered for this service.

<table>
<thead>
<tr>
<th>Table 1: Optional Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component</td>
</tr>
<tr>
<td>-----------</td>
</tr>
</tbody>
</table>
| ruleBased | The **Rule Based** component generates reports for the resources specified in the configuration files according to the rules and parameters defined in the corresponding configuration files.  
**Note:** If the **Rule Based** component is used, make sure that the ruleBased.properties file is configured. For more information, go to IBM Application Discovery Batch Server User Guide, ruleBased.properties File chapter. |
| reports   | The **Reports** component is used to generate the complexity reports. For more information, go to IBM Application Discovery Analyze User Guide, Complexity Reports chapter. |
| cobolPP   | The **cobolPP**, **jclPP**, and **pl1PP** components generate the expanded sources for Cobol, JCL, and PL/I. For more information, go to IBM Application Discovery Analyze User Guide, View Expanded Source chapter. |
| jclPP     | \n | pl1PP     | \n | wsmetrics | The **wsmetrics** component is needed only if IBM Application Delivery Intelligence (ADI) is used on the system.  
**Note:** Additionally, in order for the **wsmetrics** component to be executed, make sure that the **gdbImport** component is included in the components list of this service. |

The **Index** component will index the resources of a project so that a Search in resources can be performed in IBM Application Discovery Analyze Client, using Search in Files analysis.

index.indexFolder=\\network path\\<Folder\\Index

**Note:** For the shared path defined in the project.properties file, backslashes must be doubled (\) and spaces in the path must have a single backslash as a prefix.

So, for an index path location of:

\server01\IBM AD\Batch Server\Indexes

..the index.indexFolder parameter would be set as follows:

index.indexFolder=\\server01\\IBM\ AD\Batch\ Server\Indexes

**Important:** The Index location must be shared with all Analyze Clients, which must have read access rights.

6. On **Linux** only, Open the mount.properties file, located under <installation_folder>\IBM Application Discovery Batch Server\conf folder and specify how the windows shared folders are mounted on the local files system, using the following pattern:

\\\machine IP\\WindowsSharedFolder=/home/user/LinuxFolder
It is mandatory to mount, at least the default shared path for AD Build Projects as defined in STEP 3 and the shared path for the Indexes as defined in project.properties file (step 5c).

7. Optional step: for integration with ADI only, please follow this procedure to set up the AD Batch Server Web Service:

a. Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server \, and run authConfigTool.bat on Windows and authConfigTool.sh on Linux. A command prompt dialog window is displayed. Follow the directions and enter the username and the password that are used by the Web Service then press ENTER. AuthConfigTool.bat sets the user and password for Web Service basic access authentication.

b. Next, to generate the security certificate for the Web service: Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\ and run keystoreConfig.bat on Windows and keystoreConfig.sh on Linux. A command prompt dialog window is displayed and the keystore.jkl file is generated in the configuration folder.

Note: The path to the Java JRE's \bin folder must be in the system PATH environment variable.

What to do next

- Start IBM Application Discovery GraphDB (OrientDB).
  - Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \ IBM Application Discovery Batch Server > Start IBM Application Discovery GraphDB Service. The service can also be started from Windows Services (services.msc) by locating IBMApplicationDiscoveryGraphDBService and clicking Start.
  - Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\orientdb\orientdb-community-2.1.5_ezpatch1\bin\ and run server.sh. Make sure this process remains alive.

- Start IBM Application Discovery Batch Server.
  - Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \ IBM Application Discovery Batch Server > Start IBM Application Discovery Batch Server. The service can also be started from Windows Services (services.msc) by locating IBMApplicationDiscoveryBatchServer and clicking Start.
  - Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\, and run StartServer.sh. Make sure this process remains alive.

- (Only in case step 7 from above has been taken) Start IBM Application Discovery Web Service.
  - Under Windows: click Start and then select All Programs > IBM Application Discovery Servers \ IBM Application Discovery Batch Server > Start IBM Application Discovery Web Service. The service can also be started from Windows Services (services.msc) by locating IBMApplicationDiscoveryWebService and clicking Start.
  - Under Linux: Go to <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\, and run startWBServer.sh. Make sure this process remains alive.

Note: Make sure to restart IBM Application Discovery Batch Server after modifying the configuration files.

Important: At this installation and configuration point, everything is put in place for having analysis available in IBM AD Analyze Client. To take advantage of the available analysis functionality, you should next install the IBM AD Analyze Client, as documented in “STEP 5. Installing AD Analyze Client” on page 32.

For monitoring the Batch Server tasks, please check the logs located in the following location: <IBM ADDI Installation Folder>\IBM Application Discovery Batch Server\log\.
The log files have the following name format:

- server.log
- ibmapplicationdiscoverybatchservice -stdout.<date>.log
- ibmapplicationdiscoverybatchservice -stderr.<date>.log
- ibmapplicationdiscoverywebservice -stdout.<date>.log
- ibmapplicationdiscoverywebservice -stderr.<date>.log
- server-daemon.<date>.log
- webservice.log
- webservice-daemon.<date>.log
- status.log
- ProjectName-projectDBVersion.log
- gdbTool.log
- rb.log

**STEP 4. (Optional) Configuring AD Validation Service**

**About this task**

**IBM Application Discovery Validation Service** component is specific only for ChangeMan ZMF users, therefore it is not part of the must have components installation.

**IBM Application Discovery Validation Service** is automatically installed during the **IBM Application Discovery Build** installation.

**IBM Application Discovery Validation Service** acts like a listener and is linked directly with **IBM Application Discovery Connect for Mainframe** component (Mainframe Agents).

After **IBM Application Discovery Validation Service** is installed, go to `<IBM Application Discovery Build Client installation folder>\Bin\Release \IBMApplicationDiscoveryValidationServer\Sample conf`. Select all configuration files and copy them to `<IBM Application Discovery Build Client installation folder>\Bin\Release \IBMApplicationDiscoveryBuildClientHost_CM_Validation`.

Next, perform the following configurations.

**Procedure**

1. Configure the mapping between the projects that are used to download mainframe members, applications, and subsystems. Set the mapping values in the **ProjectsMapping.txt** file in the **ProjectName**, **ApplicationName**, **SubsystemID** format.

   **Note:** Comparing with the **ProjectsMappingParallelBuild.txt** file, the projects that are specified in the **ProjectsMapping.txt** file do not need to contain the virtual folder that is specified in the **FoldersMapping.txt** file, as they are not used for builds. However, the projects must have a z/OS connection, with IP and port numbers, attached and configured.

   **Example**

   ```
   Project1, App1, Subsys1
   ```

2. Configure **IncludesOrder.txt** to have a valid input. This is the configuration file for defining the Baseline Libraries types and the order of Cobol Includes locations. This configuration file will be used later on in the process of setting up the path for the Cobol Include folder or folders.

   The configuration file must have the following format:
<type>,<type1>,….<typen>(comma-separated values)
for example:
CPY,CPB
It is important to add the types following the order where the include files should be looked after.

3. Configure FoldersMapping.txt to have a valid input. This is the configuration file for defining a mapping between a Logical Folder of the project and the type of a member that will be part of the validation process. This configuration file is used during the synchronize phase of the validation process.

The configuration file must have the following format:
<Member Type>,<Logical folder> (comma-separated values)
for example:
COB,zOS Cobol

4. Configure ServicePort.txt to have a valid input. This is the configuration file for defining the Service's port.

The configuration file must have the following format:
<Port Number>
for example:
48000

5. Enable or disable sending feedback to the mainframe by configuring the LoopbackResults.txt file with one the following values:

Y
   Enables sending feedback to the mainframe according to the weight of rules.

N
   Disables sending feedback to the mainframe.

6. Set parallel validation parameters for the maximum-allowed values by configuring the ParallelValidationParameters.txt file with values in the format:

    Number_of_validations_in_parallel,Number_of_components_per_validation

Note:

• Do not set the number of validations in parallel greater than the number of CPU cores. Otherwise, the validation process might be unstable.

• Do not set the number of components per validation greater than 20. Otherwise, the performance might be negatively affected.

Examples

4,10
   Allows a maximum of 4 validation instances in parallel, and a maximum of 10 stages or members that are allocated for each instance. You can set these values for a computer with 4 CPU cores.

8,15
   Allows a maximum of 8 validation instances in parallel, and a maximum of 15 members that are allocated for each instance. You can set these values for a computer with 8 CPU cores.

7. Configure the mapping between the projects that are used to compile the members to be validated in parallel, applications, and subsystems. Set the mapping values in the ProjectsMappingParallelBuild.txt file in the format:

ProjectName,AppName,Subsys

Note:

• The number of the projects that are mapped to one pair of an application and a subsystem must be greater than or equal to the maximum number of validations in parallel, which is specified in the ParallelValidationParameters.txt file. Otherwise, the service cannot start.
• Comparing with the ProjectsMapping.txt file, the projects that are specified in the ProjectsMappingParallelBuild.txt file do not need to have a z/OS connection attached and configured, as they are used only for builds. However, the projects must contain the virtual folder that is specified in the FoldersMapping.txt file.

The following example shows the mapping configurations for 8 validations in parallel:

<table>
<thead>
<tr>
<th>Project1, App1, Subsys1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project2, App1, Subsys1</td>
</tr>
<tr>
<td>Project3, App1, Subsys1</td>
</tr>
<tr>
<td>Project4, App1, Subsys1</td>
</tr>
<tr>
<td>Project5, App1, Subsys1</td>
</tr>
<tr>
<td>Project6, App1, Subsys1</td>
</tr>
<tr>
<td>Project7, App1, Subsys1</td>
</tr>
<tr>
<td>Project8, App1, Subsys1</td>
</tr>
<tr>
<td>Project9, App2, Subsys1</td>
</tr>
<tr>
<td>Project10, App2, Subsys1</td>
</tr>
<tr>
<td>Project11, App2, Subsys1</td>
</tr>
<tr>
<td>Project12, App2, Subsys1</td>
</tr>
<tr>
<td>Project13, App2, Subsys1</td>
</tr>
<tr>
<td>Project14, App2, Subsys1</td>
</tr>
<tr>
<td>Project15, App2, Subsys1</td>
</tr>
<tr>
<td>Project16, App2, Subsys1</td>
</tr>
</tbody>
</table>

8. Configure completion code for messages by configuring the CompletionCodeVsMessage.txt file with values in the Code|Message format.

**Example**

```
0|Validation Success
4|Validation Warning
8|Validation Failed
10|NA
```

Each of the numbers in the example reflects the weight of the rule that is specified in the ruleBased.properties file.

9. Configure approval request parameters in the ApprovalRequestParameters.txt file with values in the ProjectName, AD_Parmlib format.

**Example**

```
project,PJ.PROCLIB.S814
```

**What to do next**

Start **IBM Application Discovery Validation Service**: Click **Start** and then select **All Programs** > **IBM Application Discovery Build Client** > **Start IBM Application Discovery Validation Service**.

The service can also be started from Windows Services (services.msc) by locating IBMApplicationDiscoveryValidationServer and pressing **Start**.

For monitoring the Validation Service tasks, please check the logs located in the following location: `<IBM Application Discovery Build Client installation path>\bin\Release\IBMApplicationDiscoveryBuildClientHost_CM_Valiidation\log\`.

The log files have the following name format:

• **ValidationServiceActivity<number>.log**: shows all the activity and actions that were executed through the service

• **ValidationServiceStatus<date>.log**: shows the state of the service (start/stop).

Secondary log file location: `<Project Folder>\Validation`.

Log files format:

• **ValidationThroughPDS_GenerateIncludePaths<date>.log**: shows the information about the copybooks path generation.
STEP 5. Installing AD Analyze Client

About this task

**Attention:** If you wish to install multiple copies of the AD Analyze Client software on the same machine or operating system instance, each copy of the AD Analyze Client software must be installed into a separate Eclipse/RDz/IDz instance, and also must use a unique workspace that does not already contain the AD Analyze Client software’s configuration settings. A workspace in use when the AD Analyze Client software is installed, and which therefore contains the AD Analyze Client software’s configuration settings will contain a folder named: `<workspace location>\.metadata\ez\.settings`

Procedure

1. To install IBM Application Discovery Analyze Client: In your Eclipse client select Window > Preferences.
2. From the Install /Update section to the left of the Preferences dialog window select Available Software Sites: A list of software sites available for update or install is displayed.
3. To select the location from where IBM Application Discovery Analyze Client is being installed click Add: The Add Site dialog window is displayed.
   - In the Name field enter a name for your IBM Application Discovery Analyze Client installation.
   - If you extracted the installation archive that you received from IBM and you stored it on your computer, use Local and point to the Repository folder generated after the extract operation.
   - If you did not extract the installation archive received from IBM, use Archive button to select the installation archive stored on your computer.
   - If you did not store the installation archive locally but in a location on your intranet, enter the full path to that location in the Location field.

   Click OK: IBM Application Discovery Analyze Client will be added to the list of Available Software Sites.

   Click OK to close the Preferences dialog window and proceed to the next step in the installation process.
4. In your Eclipse client select Help > Install New Software: The Install dialog window is displayed. In Work with field select the IBM Application Discovery Analyze Client site you have defined in the previous step. After you selected the IBM Application Discovery Analyze Client site, the corresponding IBM Application Discovery Analyze components are displayed in the central part of the dialog window. By default, all the components are selected.
   a) If you are installing AD Analyze Client into IBM RDz or IDz, you can choose all features listed under IBM Application Discovery Analyze.
   b) If you are installing AD Analyze Client into an Eclipse package not purchased from IBM, for example an Eclipse distribution downloaded from eclipse.org, you can choose features listed under IBM Application Discovery Analyze, except you should deselect all features that start with Application Discovery Integration with to avoid errors during the installation process.
   c) Once you have selected the correct features to install in your environment, click Next.
5. The Install details dialog window is displayed.

   **Note:** Select a component from the list to display a detailed description of it in the Details section of the dialog window. Click Next.

   Select a component from the list to display a detailed description of it in the Details section of the dialog window. Click Next.

6. The Review license dialog window is displayed. Carefully read the License agreement then select I accept the terms and press Finish to start the installation process.
7. After the installation is completed, Eclipse will prompt you for a restart: Accept the restart operation to see the newly installed features.

**STEP 6. AD Configuration Server: Configurations for AD Analyze**

**About this task**

**Procedure**

1. Start **IBM Application Discovery Configuration Server**, by selecting **Start > All Programs > IBM Application Discovery Configuration Service > Launch IBM Application Discovery Configuration Service Admin**.

2. Go to the environment created in “STEP 2. AD Configuration Server: Configurations for AD Build Client” on page 24 procedure step 2 and select **Configurations > Default > Graph Database** and fill in the following details:
   - Host: IP hostname where **IBM AD Batch Server** / OrientDB is installed.
   - Port: 2424.
   - Username: root.
   - Password: The same password declared in **STEP 5. Configuring AD Batch Server, procedure step 1**.

   **Note:** This is the root user's password that was defined using the server.bat or server.sh file, and it is also the same root user's password entered when gdbUserSetup.bat or gdbUserSetup.sh files were executed.

3. Optional Step and not necessary unless Java source code will be included in one or more projects in this environment and **AD Analyze Server** is installed and will be configured: Go to **Configurations > Default > Analyze Servers** and fill in the following details:
   - Host: IP / Hostname where **IBM AD Analyze Server** is installed.
   - RMI Registry Port: 1099 (Default).

**STEP 7. Configuring AD Analyze Client**

**About this task**

To configure **IBM Application Discovery Analyze Client**, follow the instructions below.

Eclipse startup is controlled by the options in **$ECLIPSE_HOME/eclipse.ini**. If **$ECLIPSE_HOME** is not defined, the default eclipse.ini in your Eclipse installation directory is used.

**Procedure**

1. **OS Dependent Configuration**: In case **Analyze Client** is installed on Windows Server (any version) or Windows 8/10, you need to edit the eclipse.ini configuration file and add the following line, in the -vmargs section. Avoid blank lines in the -vmargs section.

   ```
   -Dorg.osgi.framework.os.name=win32
   ```
2. **Memory Management Configuration**: Eclipse must be configured to allow for optimized memory consumption. To configure Eclipse, edit the `eclipse.ini` file under the Eclipse installation folder and set the minimum memory parameter (marked –Xms), the maximum memory parameter (marked –Xmx). Following is an example of an `eclipse.ini` file containing parameters for optimized memory consumption.

3. If you are using an AD-supported IBM Java version as the system Java and want to enable TLS V1.2 connection, add the following parameter in the `eclipse.ini` file in the `-vmargs` section. Avoid blank lines in the `-vmargs` section.

   `-Djsse.enableCBCProtection=false`

4. To use a specific language in the Eclipse interface, add the following parameters before the `-startup` parameter in the `eclipse.ini` file:

   `-clean`
   `-nl`
   `language`

   The following language values are supported:

<table>
<thead>
<tr>
<th>Supported language value</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>de</td>
<td>German</td>
</tr>
<tr>
<td>es</td>
<td>Spanish</td>
</tr>
<tr>
<td>fr</td>
<td>French</td>
</tr>
<tr>
<td>it</td>
<td>Italian</td>
</tr>
<tr>
<td>ja</td>
<td>Japanese</td>
</tr>
<tr>
<td>ko</td>
<td>Korean</td>
</tr>
</tbody>
</table>
Note: The -clean parameter only needs to be present once, or the first time Eclipse is configured to be used in a specific language, and can then be removed from the eclipse.ini file for the faster startup of Eclipse/RDz/IDz.

5. Go to IBM Application Discovery Analyze Client main window and select Window > Preferences > Application Discovery > Environment settings.

The following Environment identification settings are available:

- **Host**, enter the host name or the IP address of the computer where IBM Application Discovery Configuration Server is installed.
- **Port**, enter 2181, which is the default communications port for IBM Application Discovery Configuration Server.
- **Unique id**, enter the unique ID assigned by IBM Application Discovery Configuration Server to the environment you want to work with.

**Attention:** This ID must be identical to the environment ID declared in “STEP 2. AD Configuration Server: Configurations for AD Build Client” on page 24, procedure step 3.

- **Name**, enter the name of the environment with which you want to work, as defined in IBM Application Discovery Configuration Server.

**Attention:** It is highly recommended that this name is identical to the one declared in “STEP 2. AD Configuration Server: Configurations for AD Build Client” on page 24, procedure step 2.

6. Click OK and restart IBM AD Analyze Client (File Menu > Restart).

7. After restarting, a pop-up message displays the configurations defined in “STEP 6. AD Configuration Server: Configurations for AD Analyze” on page 33.

8. In order to see the Mainframe Analysis projects, go to IBM Application Discovery Analyze User Guide, Explore Projects Tab chapter.

**Notice:** At this point, all IBM Application Discovery components are up and running and ready for Analysis.

### STEP 8. (Optional) Configuring IBM AD Analyze Server

**Before you begin**

This step is optional and not necessary unless Java source code will be included in one or more projects in this environment.

**On Linux only**, Open the servermount.properties file, located under <installation folder> IBM Application Discovery Batch Server/conf folder and specify how the windows shared folders are mounted on the local files system, using the following pattern:

```
\\machine IP\\WindowsSharedFolder=/home/user/LinuxFolder
```

Example:

```
\\192.168.56.57\\ProjectsSharedPathWindows=/home/user/ ProjectsSharedPathLinux
```
It is mandatory to mount the Remote Path from **Analyze Server Manager > Server Settings**.

**About this task**

Following are the configuration steps that are needed after **IBM Application Discovery Analyze Server** was installed.

- **Under Windows**: to access the configuration parameters, select **Start > Programs > IBM Application Discovery Analyze Server > IBM Application Discovery Analyze Server Manager**.
- **Under Linux**: to access the configuration parameters, go to \<Installation Path\>\IBM Application Discovery Servers\IBM Application Discovery Analyze Server and run manager.sh.

In the **Server settings** tab, the **Server properties** and **Server arguments** sections display default data that was entered when **IBM Application Discovery Analyze Server** was installed and also, information that was entered in the **Analyze Servers** page of **IBM Application Discovery Configuration Server**. For more information, see **Installing IBM Application Discovery Configuration Server**.

To configure **IBM Application Discovery Analyze Server**, follow the instructions below.

**Procedure**

1. **Configuring the server database** – the Database settings tab:
   
   Select the **Database Settings** tab. In the Location area, fill in the following parameters:
   
   - **Server type** field is completed by default with **SQL server**.
   - **Server IP**: Enter the IP of the computer where SQL Server is installed.
   - **Server port**: Server port is the access port, by default, 1433 port is used.

   **Important**: Make sure that the IP address and the port number you set here are the same as the ones entered in the **Relational database servers** page of **IBM Application Discovery Configuration Server**. For more information, see “ **STEP 2. AD Configuration Server: Configurations for AD Build Client** ” on page 24.

   **Database instance**, this field must be used in case the default database name was not chosen at SQL Server installation time. In the Authorization area, fill in the following parameters:
   
   - **Database name**: Enter a name for the database.
   - **User and password**: Give a user and password that can be used to create the database.

   After you completed the details of the database, click **Create database** to create the database with the selected parameters. If the database was configured correctly, after **Test database** is clicked, a message with the installed DB version will be displayed. Click **Save** to apply the settings.

   You can also select an existing database. If the selected database belongs to an older version of **IBM Application Discovery** and the database structure is now obsolete, a message is displayed indicating the current version of the selected database. The user is given the option to upgrade the existing database. Press **Upgrade** if applicable. After the upgrade process was performed, press again **Test database** to make sure that the upgraded database is functional. The version of the upgraded database is presented and **Upgrade** button is no longer available. For incomplete or corrupted databases one of the following messages may be displayed: **Database x is not a valid database** or **Cannot extract relevant data from the database. Database may be nonexistent, obsolete or invalid**.

   After modifying the settings in any of the tabs, do not forget to press **Save** to apply them. An asterisk at the beginning of the title of a tab indicates that parameters in that tab were modified but not saved.

2. **Specifying allowed IBM Application Discovery Analyze Clients**:
   
   **Note**: This configuration applies only to Java projects.
   
   - **IBM Application Discovery Analyze** clients can be of two types: manager and user.
• **IBM Application Discovery Analyze** client of the *manager* type, can create shared projects, build shared projects, and delete shared projects.

• **IBM Application Discovery Analyze** client of the “user” type, can only import the shared projects and perform analysis.

Manager and user types are server-related attributes, which means that a server determines the type for a client connecting to that server by looking up the client IP in the configuration files. This means a client can be a manager on one server and a user on another server.

a) To add a Manager to the Managers list: Click **Add** in the upper right corner of the **Access Settings** tab: **New Access Data** dialog window is displayed. Enter the IP of the computer of the user who will access the server as a Manager (the type of owner is selected by default) then press **OK** to add the new manager to the list of Managers. To delete one of the Managers from the list, select it then press **Delete**. If you want to allow access to all the projects on the server to all potential users, do not add any users to the List of Users. If you want to limit the access to the projects to a number of specific users, select **restrict user IP** then add all of them to the List of Users. Only users in the List of Users and List of Managers will have access to the projects shared on the server.

b) To add a user to the List of Users, click **Add** from the List of Users area of the **Access Settings** tab: the New Access Data dialog window is displayed. Enter the IP of the computer of the user who will access the projects as a User (the type of owner is selected by default) then press **OK** to add the new user to the list of Users.

**What to do next**

**Under Windows:** start **IBM Application Discovery Analyze Server**: Click **Start** and then select **All Programs > IBM Application Discovery Analyze Server > Start IBM Application Discovery Analyze Server**.

Alternatively, to start the server: From the Start menu, choose **Programs > IBM Application Discovery Analyze Server > Start IBM Application Discovery Analyze Server Monitor** then go to monitor icon from the taskbar, right-click on the icon, and select **Start service**. When the server is running, the green arrow from **Server Monitor** icon indicates that the server is started.

**Under Linux:** Go to `<Installation Path>\IBM Application Discovery Servers\IBM Application Discovery Analyze Server` and run **StartServer.sh**. Please make sure this process remains alive.
Chapter 7. IBM AD Connect for Mainframe
Installation and Configuration

After all the steps in the Configuring IBM Application Discovery chapter are completed, you can install IBM AD Connect for Mainframe.

• Install **IBM AD Connect for Mainframe** using SMP/E, following the instructions in the **IBM AD Connect for Mainframe Program Directory**. Instructions for installing additional PTFs provided with the **IBM AD Connect for Mainframe** can be found in the installation package at:

  IBM AD v.X Suite\IBM AD Build\IBM AD Connect for Mainframe\Install instructions.

• Configure **IBM AD Connect for Mainframe** by following the instructions in the dedicated **IBM AD KnowledgeCenter** section.
Chapter 8. Activating Your IBM Application Discovery

A free IBM Application Discovery Suite is offered for evaluation purposes. This for evaluation version allows you to create a maximum of 5 projects and compile a maximum of 100 programs and 100 JCLs. After you purchase the full version, you will receive an activation tool. Following are the steps you need to take for unlocking the full functionality of IBM Application Discovery Suite.

Before you begin

Stop IBM Application Discovery Build Client and IBM Application Discovery Administration Tool before using the activation tool and make sure you run it on all machines where IBM Application Discovery Build Client is installed.

Procedure

1. Double-click the ADActivation.exe received from IBM. (Highly recommended to use Run as Administrator method)

2. Application Discovery License Activation dialog window is displayed. Click Activate then click Exit to finalize the activation.
Chapter 9. Uninstalling IBM Application Discovery Components

Important:

- Before starting the uninstall process, make sure that all IBM Application Discovery Build and IBM Application Discovery Analyze clients are closed.
- Uninstall the products in the exact order in which they are presented below.
- As a general note, understand that Force the Deletion option deletes all the contents of a specific folder, meaning that configurations are lost.
- After IBM Application Discovery Build Client is uninstalled make sure to reboot the workstation.
- In case you are upgrading and need to uninstall first, make sure to backup the configuration information. For more details on upgrading, go to Chapter 4, “Upgrading Components from Earlier Versions,” on page 15.

1. Uninstall IBM Application Discovery:

   - **Under Windows**: stop all services related to IBM AD Batch Server, IBM AD Configuration Server and IBM AD Analyze Server:
     - IBM Application Discovery Analyze Service
     - IBM Application Discovery Batch Service
     - IBM Application Discovery Configuration Admin Service
     - IBM Application Discovery Configuration Service
     - IBM Application Discovery OrientDB Service
   
   - **Under Linux**: stop all the processes related to IBM AD Batch Server, IBM AD Configuration Server, and IBM AD Analyze Server.
   
   - Stop all java processes related to IBM AD Batch Server, IBM AD Configuration Server and IBM AD Analyze Server.
   
   - **Under Windows**: click Start and then select All Programs > IBM Application Discovery and Delivery Intelligence > Unistall IBM Application Discovery and Delivery Intelligence.
   
   - **Under Linux**: Go to the installation folder (By default, the installation folder is Installation Path \IBM Application Discovery and Delivery Intelligence\Uninstall), execute uninstaller.jar and follow the uninstalling steps.
   
   - (Under Windows & Linux) Alternative CLI uninstall: open a command line in Installation Path \IBM Application Discovery and Delivery Intelligence\Uninstall and run the following command:
     ```
     java -jar uninstaller.jar -cki
     ```

2. Uninstall IBM Application Discovery Analyze Client: To uninstall IBM Application Discovery Analyze Client: Go to Eclipse client > Help > About Eclipse SDK. In the About Eclipse SDK dialog window: Click Installation Details. In the Eclipse SDK Installation Details dialog window: From the Installed Software tab, select the components that you want to uninstall then click Uninstall. The Uninstall dialog window presents the list of components that will be uninstalled: Click Finish to start the uninstall process.

© Copyright IBM Corp. 2010, 2018
Chapter 10. Disaster Recovery

Backing Up Steps for Components

I. AD Configuration Server

Note:
• Before you start to back up on Windows, make sure that the IBMApplicationDiscoveryConfigurationAdminService and IBMApplicationDiscoveryConfigurationService services are stopped.
• Before you start to back up on Linux, make sure that the startServer.sh and startWebServerUI.sh files, corresponding to AD Configuration Server, are not running.

Procedure
1. Back up folder <IBM AD Configuration Server Installation Path>\store. The database and data of Configuration Server are stored in the store folder.
2. Back up folder <IBM AD Configuration Server Installation Path>\conf. The configuration files are stored in the conf folder.

II. AD Build Client

Procedure
1. Back up AD Build projects.
   a. Back up project folders.
      1) Include the default path for AD Build projects in the backing up procedure. The default path is defined in the Default projects path field. To see the value, click the AD Build Client tab in IBM AD Configuration Server. See the following figure for illustration:

         ![IBM Application Discovery Configuration Servers Admin]

         Figure 5: Default projects path field

      2) If project folders exist in the paths that are not the default path for AD Build projects, make sure to include those paths in the backing up procedure. To identify the paths, run the following query on the SQL Server where AD Build projects exist:

         SET NOCOUNT ON;
         DECLARE @t TABLE (DB VARCHAR(100), PathStrFull VARCHAR(1000));
         DECLARE @SQL NVARCHAR(MAX);
         SELECT @SQL = STUFF((
            SELECT CHAR(13) + 'SELECT ''' + name + ''', PropValue FROM [' + name + '].[dbo].[Pj_ProjectProp] WHERE ID_PropType = 27' FROM sys.databases
            WHERE OBJECT_ID('[' + name + '].[dbo].[Pj_ProjectProp]') IS NOT NULL
            FOR XML PATH(''), TYPE).value('.', 'NVARCHAR(MAX)'), 1, 1, '');
b. Back up the databases of AD Build Client projects.

Every AD Build Client project has its own corresponding database. Include all the databases with names that start with string "EZ_" in the backing up procedure, and make sure that they can be restored at any time. See the following figure for illustration:

![Database examples](Figure 6: Database examples)

2. Back up the source code files that are loaded in AD Build Client.

a. Include the path where source code files are automatically downloaded from a Mainframe system using AD Connect for Mainframe and stored in the backing up procedure. This path is defined in the Path for the retrieved members field. To see the value, click Install Configurations > IBM Application Discovery Build Client in IBM AD Configuration Server. See the following figure for illustration:

![Path for the retrieved members field](Figure 7: Path for the retrieved members field)
b. For the source code files that are manually added or loaded in AD Build projects, make sure to include the paths where those files exist in the backing up procedure.

3. Back up AD Build configurations.

a. Back up zOS configurations. The folder where zOS configurations are stored is defined in the zOS configuration folder field. To see the value, click Install Configurations > IBM Application Discovery Build Client in IBM AD Configuration Server. See the following figure for illustration:

Figure 8: zOS configuration folder field

b. Back up the Synchronization configuration file. This file is used for Mainframe Members Synchronization Process, and is defined in the Path for members synchronization configuration file field. To see the value, click Install Configurations > IBM Application Discovery Build Client in IBM AD Configuration Server. See the following figure for illustration:
c. Back up the following Endevor configuration files:

- Promotion routes configuration file
- Types list configuration file

The two files are configured for Endevor source code download. To see the file paths, click the **ENDEVOR Info** tab in the "zOS configuration" window. See the following figure for illustration:

![Path for members synchronization configuration file](image)

**Figure 9: Path for members synchronization configuration file field**

4. Back up the following AD Validation Service configuration files. They are stored in the `<IBM AD Build Client InstallationFolder>\IBMApplicationDiscoveryValidationServer` folder.

- ApprovalRequestParameters.txt
- CompletionCodeVsMessage.txt
- FoldersMapping.txt
- IncludesOrder.txt
5. Back up the `<IBM AD Build Client InstallationFolder>\IBMApplicationDiscoveryValidationServer\ReportsGenerator` folder. By default, the conf, data, and tmp folders are contained by the ReportsGenerator folder. If the paths for the three folders are changed in the `server.properties` configuration file, back up accordingly.

6. If the Rule Based component is used, back up Rule Based reports and queries.
   a. Back up Rule Based reports.
      
      By default, the rule-based data is generated and stored in the data folder, which is already included in the backing up procedure. For more information about the data folder, see Step 5.
      
      If the default folders that are related to the Rule Based component are changed in the `project.properties` file, back up the folders as configured. If folders for specific projects are defined, back up the corresponding folders as well.

      ```
      ## output folder for rule based reports generated by source based rules. Default, data folder
      ruleBased.reportsFolder=
      
      ## output folder for csv files generated by data based rules. Default, data folder
      #ruleBased.csvFolder=
      
      ## output folder for controlTotals files generated by source based rules. Default, data folder
      ## used only if generateTotals is true
      #ruleBased.totalsFolder=
      
      ## output folder for rule based reports generated by source based rules. Default, data folder
      #project.<projectName>.ruleBased.reportsFolder=
      
      ## output folder for csv files generated by data based rules. Default, data folder
      #project.<projectName>.ruleBased.csvFolder=
      
      ## output folder for controlTotals files generated by source based rules. Default, data folder
      ## used only if generateTotals is true
      #project.<projectName>.ruleBased.totalsFolder=
      ```

   b. Back up Rule Based queries.
      
      If you use Rule Based global settings, check the paths where input and queries are stored in the `ruleBasedConfig.properties` file.
      
      If you use Rule Based project settings, check the paths where input and queries are stored in the rule properties file of each project. Also, if the rule properties files are not stored in the conf folder, back up the folders where they are stored.

III. AD Batch Server

   **Note:**
   
   • Before you start to back up on Windows, make sure that the `IBMApplicationDiscoveryBatchService`, `IBMApplicationDiscoveryGraphDBService`, and `IBMApplicationDiscoveryWebService` services are stopped.
   
   • Before you start to back up on Linux, make sure that the `server.sh` (corresponding to GraphDB), `startServer.sh` (corresponding to AD Batch Server), and `startWBServer.sh` (corresponding to AD Web Service) files are not running.
• Generally, the data and conf folders that are distributed by the AD Batch Server installation must be included in the backing up procedure. See the following detailed description for the folders.

```bash
## path to the directory where configuration files are placed
## default: ${install.dir}/conf
conf.dir=<path>/conf

## path to the directory where data files are placed
## default: ${install.dir}/data
data.dir=<path>/data

## path to the directory where temporary data is placed
## default: ${data.dir}/tmp
tmp.dir=<path>/tmp
```

**Note:** If the default paths for the data, conf, and tmp folders are changed in the `server.properties` configuration file, back up accordingly.

### Procedure

1. Back up configurations.
   a. Back up the `<Batch Server Installation Path>\Conf` configuration folder.
   b. Back up the following configuration folders in the tmp folder:
      - `<Batch Server Installation Path>\tmp\mapdb`
      - `<Batch Server Installation Path>\tmp\mfp`
      - `<Batch Server Installation Path>\tmp\sql`
      - `<Batch Server Installation Path>\tmp\ver`

2. Back up Orient databases (Graph Databases).
   Back up the default folder `<Batch Server Installation Path>\tmp\gdb`. The size of this folder might be large, depending on the number and size of AD Build Client projects.

3. Back up the index folders as defined in the `project.properties` configuration file. The indexes that are generated by AD Batch Server and used for Search In Files analysis in AD Analyze Client are stored in these folders. If indexes for specific projects are defined, back up the corresponding index folders as well.

```bash
## output folder for rule based reports generated by source based rules. Default, data folder
ruleBased.reportsFolder=
```

4. Back up the `<Batch Server Installation Path>\tmp\wsmetrics` folder. The Web Services data is stored in this folder.

5. If the Rule Based component is used, back up Rule Based reports and queries.
   a. Back up Rule Based reports.

      By default, the rule-based data is generated and stored in the data folder, which is already included in the backing up procedure. For more information about the data folder, see the preceding **Note**.

      If the default folders that are related to the Rule Based component are changed in the `project.properties` file, back up the folders as configured. If folders for specific projects are defined, back up the corresponding folders as well.

```bash
## output folder for rule based reports generated by source based rules. Default, data folder
ruleBased.reportsFolder=
```
## output folder for csv files generated by data based rules. Default, data folder
#ruleBased.csvFolder=

## output folder for controlTotals files generated by source based rules. Default, data folder
## used only if generateTotals is true
#ruleBased.totalsFolder=

## output folder for rule based reports generated by source based rules. Default, data folder
#project.\<projectName\>.ruleBased.reportsFolder=

## output folder for csv files generated by data based rules. Default, data folder
#project.\<projectName\>.ruleBased.csvFolder=

## output folder for controlTotals files generated by source based rules. Default, data folder
## used only if generateTotals is true
#project.\<projectName\>.ruleBased.totalsFolder=

b. Back up Rule Based queries.

If you use Rule Based global settings, check the paths where input and queries are stored in the ruleBasedConfig.properties file.

If you use Rule Based project settings, check the paths where input and queries are stored in the rule properties file of each project. Also, if the rule properties files are not stored in the conf folder, back up the folders where they are stored.

6. Back up the annotation database: EZ#Annotations.

AD Batch Server creates a database that is called EZ#Annotations in Microsoft SQL Server. This database is created on the SQL Server as defined in the server.properties configuration file.

![Figure 11: EZ#Annotations database](image)

IV. AD Analyze Server

**Note:**

- Before you start to back up on Windows, make sure that the IBMApplcationDiscoveryAnalyzeService service is stopped.
- Before you start to back up on Linux, make sure that the StartServer.sh file, corresponding to Analyze Server, is not running.

**Procedure**

1. Back up the Analyze Server database.

   Analyze Server creates a database in Microsoft SQL Server. To identify the Analyze Server database, start IBM Application Discovery Analyze Server, and click the **Database settings** tab. See the following figure for the illustration of the details about the SQL Server location and the database:
2. Back up the following configuration files. These three files are required for Analyze Server Service, and they are stored in folder `<IBM AD Analyze Server Installation Folder>`.

- `server.properties`
- `client.properties`
- `database.properties`

V. AD Analyze Client

Procedure

Back up the Analyze Client workspace. All information about configuration settings is stored in the Analyze Client workspace. To see the workspace location, click Windows > Preferences > Workspace.

VI. AD Web Services: Audit and Catalog

Note:

- The Audit and Catalog web services are both deployed on the same IBM WAS Liberty. Back up the two web services together because they are using the same configuration file.
- File `server.xml` is the only file that is changed and can be configured after the deployment of the Audit and Catalog web services.

Procedure

1. Back up the Audit and Catalog databases.

   Each AD Web Service requires a database. To back up the databases that are used by the Audit and Catalog web services, see the `server.xml` file and get the database connection details.

   - For the Audit web service, search for the following data source:

     ```
     <dataSource id="DefaultDataSource" jndiName="jdbc/datasource" type="javax.sql.DataSource">
     ```

   - For the Catalog web service, search for the following data source:

     ```
     <dataSource id="ADCatRDB" jndiName="jdbc/ad/catalog/relational" type="javax.sql.DataSource">
     ```

2. Back up the `server.xml` configuration file.
Add the `server.xml` file in the backup directory for web services. The `server.xml` file is under the web service installation path: `<was_liberty_path>\usr\servers\webservices`.

3. For the Catalog web service, back up the DataCollector configuration files `DC.properties` and `zoscdc.cmd`. The files are stored under the `zoscDataCollector` directory in the same location as the WAS Liberty.

**Restoring Steps for Components**

**Important:**
- All the following components must be installed, and their corresponding services (Windows) and processes (Linux) must be stopped before you start to restore.
- Make sure that you restore in the same order as mentioned in this document. Restoring in a different order might make the components not properly working because the components have dependencies.
- Make sure to maintain the same IP/Hostname values for the AD components and AD SQL Server machines when you restore, considering that AD components are using IP/Hostname values for some of their configurations.

**I. AD Configuration Server**

**Note:**
- Before you start to restore on Windows, make sure that the `IBMApplicationDiscoveryConfigurationAdminService` and `IBMApplicationDiscoveryConfigurationService` services are stopped.
- Before you start to restore on Linux, make sure that the `startServer.sh` and `startWebServerUI.sh` files, corresponding to AD Configuration Server, are not running.

**Procedure**

1. Restore the database and data of Configuration Server. For more information about the database and data, see step 1 in section backing up steps for AD Configuration Server.
2. Restore the configuration files. For more information about the files, see step 2 in section backing up steps for AD Configuration Server.

**Note:** At this point, IBM Application Discovery Configuration Server is configured and up and running.

**II. AD Build Client**

**Note:** Before you start to restore AD Build Client, AD Configuration Server must be restored, and AD Build Client is highly recommended to be installed.

**Procedure**

1. Restore AD Build projects.
   a. Restore the project folders. For more information about the folders, see substep a of step 1 in section backing up steps for AD Build Client.

   **Note:** Make sure to keep the same security/share level for each folder as they were defined.

   b. Restore the databases of AD Build Client projects. For more information about the databases, see substep b of step 1 in section backing up steps for AD Build Client.

   **Note:** Make sure to maintain the same ownership for each database as they were defined, and that the owner has all the necessary rights as defined during installation and configuration.

2. Restore the source code files that are loaded in AD Build Client. For more information about the files, see step 2 in section backing up steps for AD Build Client.
3. Restore AD Build configurations. For more information about the configurations, see step 3 in section backing up steps for AD Build Client.

**Note:**
- Make sure to keep the same security/share level for each folder as they were defined.
- At this point, IBM AD Build Client is configured and up and running, and all the projects are available and can be used.

4. Restore the AD Validation Service configuration files. For more information about the files, see step 4 and 5 in section backing up steps for AD Build Client.

5. If the Rule Based component is used, restore Rule Based reports and queries. For more information about the reports and queries, see step 6 in section backing up steps for AD Build Client.

**Note:** At this point, IBM AD Validation Service is configured, and the corresponding service can be started.

### III. AD Batch Server

**Note:**
- Before you start to restore on Windows, make sure that the IBMApplicationDiscoveryBatchService, IBMApplicationDiscoveryGraphDBService, and IBMApplicationDiscoveryWebService services are stopped.
- Before you start to restore on Linux, make sure that the `server.sh` (corresponding to GraphDB), `startServer.sh` (corresponding to AD Batch Server), and `startWBServer.sh` (corresponding to AD Web Service) files are not running.
- Before you start to restore AD Batch Server, AD Configuration Server and AD Build Client must be restored or up and running.

**Procedure**

1. Restore the configuration folders. For more information about the folders, see step 1 in section backing up steps for AD Batch Server.

2. Restore Orient databases (Graph Databases).
   a. Restore the default folder. For more information about the folder, see step 2 in section backing up steps for AD Batch Server.
   b. Re-create the symbolic links using the “recoverGDBSymbolicLinks.bat” file on page 59 on Windows and “recoverGDBSymbolicLinks.sh” file on page 59 on Linux.

   **Note:** Both of the files must be executed with the following two parameter values:

   **Location of the graph databases**
   
   "<IBM AD Batch Server Installation path>\data\tmp\gdb"

   **Location where the symbolic links must be created**
   
   "<IBM AD Batch Server Installation path>\orientdb\orientdb-community-2.1.5_ezpatch1\databases"

   Example: `recoverGDBSymbolicLinks.bat "<IBM AD Batch Server Installation path>\data\tmp\gdb" "<IBM AD Batch Server Installation path>\orientdb\orientdb-community-2.1.5_ezpatch1\databases"

3. Restore the index folders. For more information about the folders, see step 3 in section backing up steps for AD Batch Server.

   **Note:** Make sure to keep the same security/share level for each folder as they were defined.

4. Restore the Web Services data. For more information about the data, see step 4 in section backing up steps for AD Batch Server.
5. If the Rules Based component is used, restore Rules Based reports. For more information about the reports, see step 5 in section backing up steps for AD Batch Server.

6. Restore the annotation database: EZ#Annotations. For more information about the database, see step 6 in section backing up steps for AD Batch Server.

**Note:**
- Make sure to maintain the same ownership for the annotation database as it was defined, and that the owner has all the necessary rights as defined during installation and configuration.
- At this point, IBM AD Batch Server is configured, and all the corresponding services (Windows) and processes (Linux) can be started.

**IV. AD Analyze Server**

**Note:**
- Before you start to restore on Windows, make sure that the IBMApplicationDiscoveryAnalyzeService service is stopped.
- Before you start to restore on Linux, make sure that the StartServer.sh file, corresponding to Analyze Server, is not running.

**Procedure**

1. Restore the Analyze Server database. For more information about the database, see step 1 in section backing up steps for AD Analyze Server.

   **Note:** Make sure to maintain the same ownership for the Analyze Server database as it was defined, and that the owner has all the necessary rights as defined during installation and configuration.

2. Restore the Analyze Server configuration files. For more information about the files, see step 2 in section backing up steps for AD Analyze Server.

   **Note:** At this point, IBM AD Analyze Server is configured, and all the corresponding services (Windows) and processes (Linux) can be started.

**V. AD Analyze Client**

**Procedure**

1. Restore the Analyze Client workspace. For more information about the workspace, see the procedure in section backing up steps for AD Analyze Client.

2. Set the Analyze Client Eclipse to use the backup workspace.
   - Open the Analyze Client instance.
   - Click **File > Switch workspace > Other...**
   - Select the backup workspace.

   **Note:** At this point, IBM AD Analyze Client is configured and ready to use for analysis.

**VI. AD Web Services: Audit and Catalog**

**Procedure**

1. Restore the Audit and Catalog databases. For more information about the databases, see step 1 in section backing up steps for AD Web Services: Audit and Catalog.

   **Note:** Make sure to maintain the same ownership for each database as it was defined, and that the owner has all the necessary rights as defined during installation and configuration.

2. Restore the server.xml configuration file. For more information about the file, see step 2 in section backing up steps for AD Web Services: Audit and Catalog.
If the database connection details were changed, edit the server.xml file to point to the correct location of the SQL/DB2 server, and change the credentials accordingly.

3. For the Catalog web service, restore the DataColector configuration files DC.properties and zoscdc.cmd. For more information about the files, see step 3 in section backing up steps for AD Web Services: Audit and Catalog.

Create a directory <was_liberty_path>\zoscDataCollector, and put the DataColector configuration files in it.

**Note:** At this point, IBM AD Audit and Catalog are configured, and all their services (Windows) and processes (Linux) can be started.
IBM Application Discovery generates IBM Software License Metric Tag (SLMT) files. The versions of IBM License Metric Tool that support IBM Software License Metric Tag can generate License Consumption Reports.

Each instance of a running environment generates an IBM Software License Metric Tag file. The USER metrics are monitored. The values are refreshed every 10 minutes.

IBM Application Discovery generates an SLMT tag file that records the active user count at 10 minutes intervals. The recorded information is:

- **USER**: containing the name of the system account that started the AD Analysis Client.
- **INSTANCE**: containing the workspace of the AD Analysis Client.
- **APPLICATION_INSTANCE**: a unique identifier of the current workspace of AD Analysis Client.

IBM SLM tag files are found at `work/.metadata/.ez/.slmtag` for Linux and `work\.metadata\.ez\.slmtag` for Windows. This is a relative path where `work` is the name of the workspace used for the IBM Application Discovery Analyze Client installation.

Following is an example of the content of an SLM tag file:

```xml
<SchemaVersion>2.1.1</SchemaVersion>
<SoftwareIdentity>
  <PersistentId>e187f9ed93d4a3fb9cda4c1c442bb1</PersistentId>
  <Name>IBM Application Discovery</Name>
  <InstanceId>/eviewer/workspace/.metadata/.ez/.slmtag</InstanceId>
</SoftwareIdentity>
<Metric logTime="2017-11-14T16:02:39+02:00">
  <Type>USER</Type>
  <SubType>adriana</SubType>
  <Value>13</Value>
  <Period>
    <StartTime>2017-11-14T16:02:39+02:00</StartTime>
    <EndTime>2017-11-14T16:02:39+02:00</EndTime>
  </Period>
</Metric>
<Metric logTime="2017-11-14T16:02:39+02:00">
  <Type>INSTANCE</Type>
  <SubType>/eviewer/workspace</SubType>
  <Value>13</Value>
  <Period>
    <StartTime>2017-11-14T16:02:39+02:00</StartTime>
    <EndTime>2017-11-14T16:02:39+02:00</EndTime>
  </Period>
</Metric>
<Metric logTime="2017-11-14T16:08:10+02:00">
  <Type>USER</Type>
  <SubType>adriana</SubType>
  <Value>13</Value>
  <Period>
    <StartTime>2017-11-14T16:08:10+02:00</StartTime>
    <EndTime>2017-11-14T16:08:10+02:00</EndTime>
  </Period>
</Metric>
<Metric logTime="2017-11-14T16:08:10+02:00">
  <Type>INSTANCE</Type>
  <SubType>/eviewer/workspace</SubType>
  <Value>13</Value>
  <Period>
    <StartTime>2017-11-14T16:08:10+02:00</StartTime>
    <EndTime>2017-11-14T16:08:10+02:00</EndTime>
  </Period>
</Metric>
```
recoverGDBSymbolicLinks.bat file

@echo OFF
setlocal enabledelayedexpansion
SET batchOrientDBFolder=%1
SET batchOrientDBFolder=%batchOrientDBFolder:~1%
SET batchOrientDBFolder=%batchOrientDBFolder:~0,-1%

SET orientDBFolder=%2
SET orientDBFolder=%orientDBFolder:~1%
SET orientDBFolder=%orientDBFolder:~0,-1%

for /f "tokens=*" %%G in ('dir /b /s /a:d "%batchOrientDBFolder%\gdb-*"') do (CALL :createSymolicLink "%%~nG" "%%G" "%orientDBFolder%"
REM Recreate symbolic link in case of a disaster
GOTO :EOF

:createSymolicLink
SET name=%1
SET name=%name:~1%
SET name=%name:~0,-1%
SET path=%2
SET path=%path:~1%
SET path=%path:~0,-1%
SET target=%3
SET target=%target:~1%
SET target=%target:~0,-1%

ECHO %name%>tempfile.txt
FOR %%? in (tempfile.txt) do (set /A str_length=%%~z? - 2 )&del tempfile.txt
SET /A _length=%str_length%
SET "batchOrientDBName0=%name%"
_SET_startchar=4
CALL SET _substring=%%batchOrientDbName0:~%_startchar%,%_length%%%
for /f "tokens=1 delims=-" %%i in (%_substring%) do (set orientDbName=%%i)
SET "orientLink=%target%\%orientDbName%"
ECHO %orientLink%
MKLINK /D "%orientLink%" "%path%"
GOTO :EOF

recoverGDBSymbolicLinks.sh file

#!/bin/bash
#this script is used to recreate the symbolic link in case of a disaster recovery procedure
#the script receives two directories as arguments and will create symbolic links for all the gdb databases
#the first argument is the location with the orientDB databases created by Batch server
#the second argument is the location where the orientDB server expects to find the databases
#example of usage:
#./recoverGDBSymbolicLinks.sh <arg1> <arg2>
# <arg1>="/home/adriana/IBM Application Discovery Batch Server/data/tmp/gdb"
# <arg2>="/home/adriana/IBM Application Discovery Batch Server/orientdb/orientdb-community-2.1.5_ezpatch1/
# databases"
batchGdbDir=$1
orientGdbDir=$2
for entry in "$[batchGdbDir]"/*gdb-*
do
gdbName=$(basename "$entry")
prefix="gdb-"
gdbName=${gdbName##$prefix}
projectName=${gdbName%%$prefix}

ln -s "$entry" "$[orientGdbDir]/$[projectName]"
done
Documentation Notices for IBM Application Discovery

This edition applies to version 5.0.5 of IBM Application Discovery with the corresponding fix packs.


This information was developed for products and services offered in the US. This material might be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property
Law
IBM Japan Ltd.
19-21, Nihonbashi-
Hakozakicho, Chu-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in
any manner serve as an endorsement of those websites. The materials at those websites are not part of
the materials for this IBM product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US
Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

Statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject to change without notice. Dealer prices may vary. This information is for planning purposes only.

The information herein is subject to change before the products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to actual people or business enterprises is entirely coincidental.

COPYRIGHT LICENSE: This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright notice as follows: © (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. © Copyright IBM Corp. _enter the year or years_.

**Trademarks**

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the web Copyright and trademark information.